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Preface

Welcome to Sun JavaTM Communications Suite. The Sun Java Communications Suite delivers
industry-leading email, calendaring and real-time collaboration functionality for service
providers and large organizations worldwide. The suite provides an extensible, standards-based
development platform, offering improved performance, reliability and scalability at a lower
total cost of ownership. This guide provides demos that enable you to use, learn about, and
evaluate the Sun Java Communications Suite software.

Who Should Use This Book
This guide is intended for any evaluator, system administrator, or installation technician who
wants to evaluate the services delivered by Sun Java Communications Suite.

Before You Read This Book
To use this guide, you need an evaluation system that has Communications Suite software
installed. See the document titled Deployment Example: Sun Java Communications Suite 5 on a
Single Host for instructions on how to build a complete test system before using this guide.

What This Book Covers
This document complements the single host installation document and is meant to assist you in
using and evaluating the platform once it has been installed. This document provides demos
organized by Communications Suite component product area. Within these areas, several
features are presented. A complete list of component areas and features is provided below.

■ Communications Express overview
■ Messaging demo:

■ HTML editor
■ Spelling check
■ Advanced search
■ Advanced folder topics
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■ Options and filters
■ Calendaring demo:

■ User interface layout
■ Calendar views (month, week, day, and so forth)
■ Viewing other calendars
■ Calendar subscription and creation/ownership/permissions/time zones
■ Calendar groups (personal enterprise/service provider)
■ Event creation/group scheduling
■ Event/Invitations view
■ Searching (calendars and events within calendars)
■ New task creation
■ Import/export
■ Options/time zones

■ Address Book demo:
■ Integration between Address Book and Mail/Calendar
■ Address Book management
■ Quick Address Book creation

■ Connector for Microsoft Outlook interoperability demo:
■ Calendar drag and drop
■ Mail compose and view
■ Address Book creation
■ Return to Communications Express

■ Instant Messaging demo:
■ Contacts and contact groups
■ Chat with online buddy
■ Multimedia chat
■ Multiple simultaneous chat sessions
■ Invite others to chat
■ Alerts and polls
■ Conference room management
■ Moderating a conference room
■ Access and privacy filters
■ API filters
■ Access Manager provisioning and filtering
■ Archiving Instant Messaging
■ HTTP proxy

■ Delegated Administration demo:
■ Creating domains
■ Creating users

Preface
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Related Books
The URL for all documentation about Sun Java Communications Suite is:

http://docs.sun.com/app/docs/prod/sj.comm.suite#hic

Typographic Conventions
The following table describes the typographic changes that are used in this book.

TABLE P–1 Typographic Conventions

Typeface Meaning Example

AaBbCc123 The names of commands, files, and
directories, and onscreen computer
output

Edit your .login file.

Use ls -a to list all files.

machine_name% you have mail.

AaBbCc123 What you type, contrasted with onscreen
computer output

machine_name% su

Password:

AaBbCc123 A placeholder to be replaced with a real
name or value

The command to remove a file is rm filename.

AaBbCc123 Book titles, new terms, and terms to be
emphasized (note that some emphasized
items appear bold online)

Read Chapter 6 in the User's Guide.

A cache is a copy that is stored locally.

Do not save the file.

Shell Prompts in Command Examples
The following table shows default system prompts and superuser prompts.

TABLE P–2 Shell Prompts

Shell Prompt

C shell on UNIX and Linux systems machine_name%

C shell superuser on UNIX and Linux systems machine_name#

Bourne shell and Korn shell on UNIX and Linux systems $

Bourne shell and Korn shell superuser on UNIX and Linux systems #

Preface
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TABLE P–2 Shell Prompts (Continued)
Shell Prompt

Microsoft Windows command line C:\

Symbol Conventions
The following table explains symbols that might be used in this book.

TABLE P–3 Symbol Conventions

Symbol Description Example Meaning

[ ] Contains optional
arguments and command
options.

ls [-l] The -l option is not required.

{ | } Contains a set of choices for
a required command option.

-d {y|n} The -d option requires that you use
either the y argument or the n
argument.

${ } Indicates a variable
reference.

${com.sun.javaRoot} References the value of the
com.sun.javaRoot variable.

- Joins simultaneous multiple
keystrokes.

Control-A Press the Control key while you press
the A key.

+ Joins consecutive multiple
keystrokes.

Ctrl+A+N Press the Control key, release it, and
then press the subsequent keys.

→ Indicates menu item
selection in a graphical user
interface.

File → New → Templates From the File menu, choose New.
From the New submenu, choose
Templates.

Accessing Sun Resources Online
The docs.sun.com web site enables you to access Sun technical documentation online. You can
browse the docs.sun.com archive or search for a specific book title or subject. Books are
available as online files in PDF and HTML formats. Both formats are readable by assistive
technologies for users with disabilities.

To access the following Sun resources, go to http://www.sun.com:

■ Downloads of Sun products
■ Services and solutions
■ Support (including patches and updates)
■ Training
■ Research

Preface
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■ Communities (for example, Sun Developer Network)

Third-Party Web Site References
Third-party URLs are referenced in this document and provide additional, related information.

Note – Sun is not responsible for the availability of third-party web sites mentioned in this
document. Sun does not endorse and is not responsible or liable for any content, advertising,
products, or other materials that are available on or through such sites or resources. Sun will not
be responsible or liable for any actual or alleged damage or loss caused or alleged to be caused by
or in connection with use of or reliance on any such content, goods, or services that are available
on or through such sites or resources.

Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and
suggestions. To share your comments, go to http://docs.sun.com and click Send Comments.
In the online form, provide the full document title and part number. The part number is a
7-digit or 9-digit number that can be found on the book's title page or in the document's URL.
For example, the part number of this book is 820–2199–10.

Preface
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Sun Java Communications Suite Highlights

This chapter describes the key features and benefits of Sun Java Communications Suite.

Sun Java Communications Suite is a secure, cost-effective communications and collaboration
offering. Communications Suite addresses customer concerns about the costs, capabilities, and
security of a traditional communications infrastructure by offering a secure, scalable, lower
total cost of ownership alternative to other communications and collaboration solutions.

Communications Suite provides the email, calendar, and instant messaging solutions necessary
to meet both enterprise and service provider communications and collaboration needs. All
organizations need communications, and many are required to provide these services across
large, diverse, and geographically distributed communities of users. Traditional
communications solutions are costly, and not sufficient to meet today’s requirements for
scalability and security. Communications Suite enables organizations to deploy solutions at a
total cost of ownership they can afford.

In addition, Communications Suite provides differentiated services and full-featured
collaboration functionality that are required by a diverse audience. Finally, a Communications
Suite deployment meets your increased security needs when extending communications
outside of a corporate firewall and to mobile users through multiple devices.

The Communications Suite core solution consists of the following components:

■ Sun Java System Messaging Server
■ Sun Java System Calendar Server
■ Sun Java System Instant Messaging

Additional features that enhance the Communications Services solution include:

■ Sun Java System Communications Express
■ Sun Java System Communications Sync
■ Sun Java System Connector for Microsoft Outlook

This chapter contains the following sections:

1C H A P T E R 1
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■ “Messaging Server Features” on page 14
■ “Calendar Server Features” on page 14
■ “Instant Messaging Features” on page 15
■ “Communications Express Features” on page 15
■ “Communications Sync Features” on page 15
■ “Connector for Outlook Features” on page 16

Messaging Server Features
Sun Java System Messaging Server is a high-performance, highly secure messaging platform.
Scaling from thousands to millions of users, Messaging Server is suitable for businesses
interested in consolidating email servers and reducing total cost of ownership of the
communications infrastructure. Messaging Server provides extensive security features that help
ensure the integrity of communications through user authentication, session encryption, and
the appropriate content filtering to help prevent spam and viruses. Messaging Server also can
provide an archive for instant messaging communications. Furthermore, Messaging Server
supports archiving through the Sun Compliance and Content Management System powered by
the AXS-One Compliance Platform to provide an industrial strength message archiving
solution for both compliance and operational archiving.

With Messaging Server, organizations can provide secure, reliable messaging services for entire
communities of employees, partners, and customers.

For more information about Messaging Server features, see the following documentation:
http://docs.sun.com/app/docs/coll/1312.2

Calendar Server Features
Sun Java System Calendar Server facilitates team collaboration by enabling users to manage and
coordinate appointments, events, tasks, and resources. With its intuitive, web-based interface,
Calendar Server enables end users to access their personal, public, or group calendars anytime
and anywhere, from a web browser. Deployments use Calendar Server, along with the
Messaging Server and Instant Messaging, to offer users a comprehensive communications and
collaborative environment.

For more information about Calendar Server features, see the following documentation:
http://docs.sun.com/app/docs/coll/1313.2

Messaging Server Features
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Instant Messaging Features
Sun Java System Instant Messaging enables secure, real-time communication and collaboration.
Instant Messaging combines presence awareness with instant messaging capabilities such as
chat, conferences, alerts, news, polls, and file transfers to create a collaborative environment.
These features enable one-to-one as well as group collaboration through either short-lived
communications or persistent venues such as conference rooms or news channels. Instant
Messaging, along with Calendar Server and Messaging Server, offers users a comprehensive
communications and collaboration environment.

Instant Messaging ensures the integrity of communications through its multiple authentication
mechanisms and secure SSL connections. Integration with Sun Java System Portal Server and
Sun Java System Access Manager brings additional security features, services-based
provisioning access policy, user management, and secure remote access. Furthermore, Instant
Messaging supports the Extensible Messaging and Presence Protocol (XMPP). XMPP enables
you to use a number of third-party clients, gateways, and components. Some of these clients
aggregate contacts from the public networks. In one client, you can have contacts from AIM,
Yahoo, MSN, Sun, and other XMPP-based servers.

For more information about Instant Messaging features, see the following documentation:
http://docs.sun.com/app/docs/coll/1309.3

Communications Express Features
Sun Java System Communications Express provides an integrated web-based communications
and collaboration client. Communications Express is a common component between
Messaging Server and Calendar Server, providing end users with a web interface to their
calendar information and mail, as well as an address book.

For more information about Communications Express features, see the following
documentation: http://docs.sun.com/app/docs/coll/1631.1

Communications Sync Features
Communications Sync is a software product that runs on the Windows platform and enables
users to synchronize Communications Suite events, tasks, and contacts with mobile devices and
personal information managers (PIMs) such as Microsoft Outlook.

See the Sun Java Systems Communications Sync 3.0 Release Notes in the following collection for
more information: http://docs.sun.com/app/docs/coll/1313.2

Communications Sync Features
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Note – Communications Sync is not used in this evaluation.

Connector for Outlook Features
Sun Java System Connector for Microsoft Outlook enables Outlook to be used as a desktop
client with Messaging Server and Calendar Server.

Connector for Microsoft Outlook is an Outlook plug-in that you install on end-users desktops.
Connector for Microsoft Outlook queries Messaging Server for folder hierarchies and email
messages. Connector for Microsoft Outlook then converts the information into Messaging API
(MAPI) properties that Outlook can display. Similarly, Connector for Microsoft Outlook
queries Calendar Server for events and tasks, which are then converted into MAPI properties.
Connector for Microsoft Outlook uses Web Address Book Protocol (WABP) to query Address
Book Server for contacts, which are then converted into MAPI properties. With this model,
Connector for Microsoft Outlook builds an end-user Outlook view from three separate
information sources: mail from Messaging Server, calendar information from Calendar Server,
and contacts from Address Book Server.

For more information about Connector for Microsoft Outlook features, see the following
documentation: http://docs.sun.com/app/docs/coll/1630.1

Connector for Outlook Features
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Preparing to use the Communications Suite
Evaluation

This chapter describes what you need to do to prepare to run the evaluation, including meeting
the requirements for the evaluation system and creating user accounts and sample data.

This chapter contains the following sections:

■ “Using the Single Host Deployment Example” on page 17
■ “Client System Interoperability Requirements for this Evaluation” on page 18
■ “Creating User Accounts for This Evaluation” on page 20
■ “Creating Sample Data for This Evaluation” on page 23

Using the Single Host Deployment Example
This evaluation assumes that you have installed all of the Communications Suite software on a
single host as outlined in the document Deployment Example: Sun Java Communications Suite 5
on a Single Host.

Follow the instructions in the deployment example before continuing with this document.

The single host deployment example was installed using the following data. If appropriate,
substitute the host name that you used in place of wireless.map.beta.com.

TABLE 2–1 Single Host Deployment Example Data

Item Value Notes

Host name wireless.map.beta.com

Communications Express
URL

http://wireless.map.beta.com/uwc

Instant Messaging URL http://wireless.map.beta.com/im

2C H A P T E R 2
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TABLE 2–1 Single Host Deployment Example Data (Continued)
Item Value Notes

Delegated Administrator
URL

http://wireless.map.beta.com/da/DA/Login

Top-level administrator ID amadmin Used for logging into Access Manager and
Delegated Administrator.

Administrative password adminpass For all administrative users except
amldapuser.

amldapuser password nonadminpass

User accounts duncan, kathy, tina, robert, test

User password demo For all accounts.

User creation /opt/SUNWcomm/bin/commadmin See “Creating User Accounts for This
Evaluation” on page 20 for more
information.

Ports Web/AddressBook/UWC: 80 (new UI)

Webmail: 8080 (legacy UI)

Webcal: 3080 (legacy UI)

LDAP: 389

SMTP: 25

User Base DN o=isp

Organization DN o=map.beta.com,o=isp Used for Connector for Microsoft Outlook.

Note – You should be able to use this guide with any system that has the Communications Suite
software installed. However, the names, paths, passwords, and so forth mentioned in this guide
might differ from the data you use.

Client System Interoperability Requirements for this
Evaluation

A key benefit of Sun Java Communications Suite is its interoperability with other
communications components and solutions. This evaluation demonstrates interoperability
with Gaim and Microsoft Outlook. Gaim demonstrates the XMPP-based interoperability of
Sun's Instant Messaging solution. This evaluation assumes you are using Java Web Start 1.4.2.
Java Web Start 1.5 also works if certain certificate signing conditions are met. Enable your
browser to allow pop-up windows.

Client System Interoperability Requirements for this Evaluation
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Download the additional software from the following locations.

Gaim http://gaim.sourceforge.net

Java Web Start 1.4.2 http://java.sun.com/j2se/1.4.2/download.html

Simply install the J2SE JRE as Java Web Start is contained within the
JRE.

▼ To Configure Gaim for This Evaluation
After you download and install Gaim on your client system, you must configure Gaim with a
user account that connects to the Sun Java System Instant Messaging server. If the user robert
has already been created, proceed with the following steps. If you have not yet created this user,
you will be able to create a Gaim account for this user but you will not be able to log in until you
create a user account for robert. The following shows you how to create user accounts. Upon
creating a user account for robert, you will be able to log in to Gaim as this user.

Start Gaim.

Click the Accounts icon.

Click Add in the Accounts window and type the following information.
Protocol Jabber

Screen Name robert

Server wireless.map.beta.com

Resource Gaim

Password demo

Alias Robert

Click Save button to save the options.

Click Close in the Accounts window.

Use the Account drop-down menu in the main Gaim window to select the account.

Type the password demo for the account and click the Sign on icon.

Accept any subsequent dialog boxes that appear.

1

2

3

4

5

6

7

8

Client System Interoperability Requirements for this Evaluation
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Creating User Accounts for This Evaluation
This evaluation makes use of a number of user accounts. These user accounts are duncan
(Duncan Hoff), kathy (Kathy Singer), tina (Tina Givens), robert (Robert Smith), and test,
with a password of demo for all user accounts. After you create these accounts, you use them to
create some sample email and calendar data.

▼ To Create User Accounts for This Evaluation
Use the Delegated Administrator command-line utility commadmin to create user accounts.
/opt/SUNWcomm/bin/commadmin user create -D admin -F first-name -l userid -L last-name
-n map.beta.com -p 80 -w adminpass -W demo -X wireless.map.beta.com -S mail,cal -E

userid@map.beta.com -H wireless.map.beta.com

first-name Represents the user's first name.

userid Represents the user ID.

last-name Represents the user's last name.

Create the user accounts for the demo scenarios in this guide by following these examples.
/opt/SUNWcomm/bin/commadmin user create -D admin -F Duncan -l duncan -L Hoff -n

map.beta.com -p 80 -w adminpass -W demo -X wireless.map.beta.com -S mail,cal -E

duncan@map.beta.com -H wireless.map.beta.com

/opt/SUNWcomm/bin/commadmin user create -D admin -F Kathy -l kathy -L Singer -n

map.beta.com -p 80 -w adminpass -W demo -X wireless.map.beta.com -S mail,cal -E

kathy@map.beta.com -H wireless.map.beta.com

/opt/SUNWcomm/bin/commadmin user create -D admin -F Tina -l tina -L Givens -n

map.beta.com -p 80 -w adminpass -W demo -X wireless.map.beta.com -S mail,cal -E

tina@map.beta.com -H wireless.map.beta.com

/opt/SUNWcomm/bin/commadmin user create -D admin -F Robert -l robert -L Smith -n

map.beta.com -p 80 -w adminpass -W demo -X wireless.map.beta.com -S mail,cal -E

robert@map.beta.com -H wireless.map.beta.com

/opt/SUNWcomm/bin/commadmin user create -D admin -F Test -l test -L User

-n map.beta.com -p 80 -w adminpass -W demo -X wireless.map.beta.com -S mail,cal -E

test@map.beta.com -H wireless.map.beta.com

1

2

Creating User Accounts for This Evaluation
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▼ To Add Auxiliary Services to Users
After creating users, use the Access Manager console to verify that the required auxiliary
services have been added to each user.

In a web browser, type the URL for the Access Manager console.
http://hostname/amconsole

For example, http://wireless.map.beta.com/amconsole.

Log in as amadminwith a password adminpass.
You see a view of the available organizations. Click the link of your main organization
map.beta.com.

In the left pane, select Users from the View drop-down menu.
You should see your primary users Duncan, Kathy, Tina, Robert, and test.

Click the property arrow beside Duncan Hoff's name.

In the right pane, select Services from the View drop-down menu.
Verify that the Instant Messaging and Presence Services are listed as available services. If they
are not listed, continue with the remaining steps below to add these services. If these services do
exist, skip to step 9.

Click Add in the right pane to add services.

Select the check box at the top that contains an icon of two check marks.
This check box selects all services.

Click OK at the bottom to verify your selection.

Repeat steps 4 through 8 for users Kathy, Robert, Tina, and Test.

Grant additional access rights to the main user in the next task.

▼ To Grant Additional Access Rights to Users
This procedure gives special access controls to the main user Duncan.

In the left pane of the Access Manager console, click the isp link near the Identity Management
tab.
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Select Roles from the View drop-down menu in the left pane.

To assign a user to the IM Conference Rooms Administrator role, click the property arrow beside
the IM Conference Rooms Administrator.

In the right pane, select Users from the View drop-down menu.

Click Add in the right pane.

In the User ID field, type duncan and click Next.

Select the check box next to Duncan's name and click Finish.
Now Duncan has permission to create conference rooms.

Click the Service Configuration tab.
The left pane displays a list of services.

Click the property arrow beside the Session service.

Scroll to the bottom of the list of attributes and change the following to enable you to complete
the evaluation without experiencing auto timeouts:
Maximum Session Time 960

Maximum Idle time 720

Click Save.

Log out of the Access Manager Console.

(Recommended) Restart the Instant Messaging server. You must be logged in as root to
perform this task.
cd /opt/SUNWiim/sbin

./imadmin refresh

(Recommended) Restart the Web Server.
cd /var/opt/SUNWwbsvr7/https-wireless.map.beta.com/bin

./stopserv

./startserv

Note – After making changes to the Access Manager configuration and Instant Messaging
policies, it is recommended to restart Instant Messaging and Access Manager.
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Create sample data in the next task.

Creating Sample Data for This Evaluation
Prior to executing the evaluation , you need to configure the user accounts for sharing data and
prepare the system for many of the scenarios that you use later in the evaluation. In addition,
these procedures introduce you to some of the basic functionality of the Sun Java
Communications Suite.

In this section, you are introduced to basic functionality as you create the following:

■ Sample address book data
■ Sample messaging and calendaring data
■ Sample resources
■ Sample Instant Messaging data

▼ To Create a Sample Address Book with Data for the
Main User

In a web browser, type the URL for Communications Express.
http://hostname/uwc.

For example, http://wireless.map.beta.com/uwc.

Log in as the main user duncanwith the password demo.
You are now logged into Communications Express with the Mail tab selected as the default.

Click the Calendar tab to view the Calendar.

Click the Address Book tab to view the Address Book.

To add contacts, type the contact's information in the Add Contact section.

a. In the First field, type Robert.

b. In the Last field, type Smith.

c. In the Email field, type robert@map.beta.com.

d. Click the Add Contact button.
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Repeat step 5 for contacts Kathy Singer and Tina Givens.
An alternate way to create contacts that enables you to enter more information is through the
New Contact icon in the Address Book UI.

Click the New Contact icon.
A New Contact window appears.

a. In the First Name field, type Duncan.

b. In the Last Name field, type Hoff.

c. In the Primary Email field, type duncan@map.beta.com.

d. Type any additional information you choose.

e. Click Save to create the contact.

Click Log Out to log off as Duncan from Communications Express.

Create more sample data in the next task.

▼ To Create Sample Messaging and Calendaring Data
This procedure configures Messaging Server and Calendar Server so that the main demo user,
Duncan, has email in his inbox and invitations in his calendar. This procedure also introduces
you to the basic mail and calendar functionality provided by Sun Java Communications Suite.
In these steps, you learn how to create invitations and how to modify the permissions on your
calendar so that others can view your appointments. You also create calendar resources.

You should already have the Communications Express login screen displayed in your web
browser.

Log in as user tinawith the password demo.

To display Tina's calendar, click the Calendar tab.

From the Current Calendar drop-down menu, select Manage Calendars.
The Manage Calendars window appears that displays information about the Personal Calendar
for Tina Givens.

To change calendar permissions, click the Edit link in the Properties column.
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In the Edit Calendar window, select the Anyone Can Read My Calendar check box.

Click Save to save the calendar.

Click the Week view at the top of the Calendar UI.

To create an appointment, click the New Event icon.
The New Event window appears.

Fill in the event template.

a. Type a title for the event, a start date and time, an end date and time, and a location.

b. To invite Duncan, type duncan in the Invitee field.

c. Click Add.

Click Save to create the event and invite Duncan.

Click the Log Out link to log off Tina from Communications Express.

Log in as user kathywith the password demo and repeat steps 2 through 11.
Create the event for a different date and time, but be sure to invite Duncan.

Click the Log Out link to log off Kathy from Communications Express.

Log in as user robertwith the password demo.

Repeat steps 2 through 6 to make Robert's calendar readable by others.
Do not create a new invitation.

Create more sample data in the next task.

▼ To Create Sample Resources
You can use Calendar Server to schedule both people and resources, such as conference rooms
and audio/visual equipment. To schedule resources, you must first create the resources.

You must be logged in as root to perform this task.
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In a terminal window, type the following.
cd /opt/SUNWics5/cal/sbin

./csresource -m calmaster@map.beta.com -c RoomA create RoomA

./csresource -m calmaster@map.beta.com -c ProjectorA create ProjectorA

These commands create two resources (RoomA and ProjectorA) that will be used in subsequent
exercises.

Log out as root.

Create sample messages in the next task.

▼ To Create Sample Messages
This task guides you through the process of composing email. While logged in as Robert, you
compose a few messages to verify that Messaging Server is functioning properly and also ensure
that Duncan has email in his inbox.

To display Robert's mail, click the Mail tab at the top of the Communications Express UI.

To send a test email to Duncan, click the Compose link.

a. In the To field, type duncan@map.beta.com.

b. In the Subject field, type Vacation last Month.

c. In the main body of the message, type I discovered many herbal remedies during my

vacation last month. as the message content.

d. Click Send to send the message.

To send a test email to Duncan with urgent priority, compose a second message.

a. In the To field, type duncan@map.beta.com.

b. In the Subject field, type Urgent: Please Review.

c. In the main body of the message, type Duncan, please review this document ASAP.

d. In the Priority drop-down menu, change the message priority to Urgent.
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e. To attach a document, click the Attach icon at the top of the New Message window to attach
a document.
An Attach File window appears.

f. Use the Browse button to identify any document, and click Add to add the document to the
attachment list.

g. Click Attach to attach the document to the email.

h. Click Send to send the urgent email to Duncan.
Duncan will receive this urgent email when he logs in later.

Click the Log Out link to log off Robert from Communications Express.

Create more sample data in the next task.

▼ To Create Sample Instant Messaging Data
In this procedure, you start Instant Messenger, and create the buddy lists for each of the four
users in the demo. The Instant Messenger channel will recognize that other users are logged in
and will present the status of online buddies as the main user logs in.

To start Instant Messenger as users duncan, robert, and kathy, you can use a multi-protocol
client such as Gaim as well as Sun's Instant Messenger client. If you have problems logging into
Instant Messaging by using Java Web Start, check for problems with certificate signing. If so, try
Java Web Start minimum 1.4.2. Using Gaim is not essential, however, by using Gaim, you view
the interoperability of the Instant Messaging solution.

See “To Configure Gaim for This Evaluation” on page 19 for instructions on downloading and
installing Gaim, and for configuring a Gaim user account.

Using the Gaim client, log in to Instant Messaging as user robertwith the password demo.

Start a web browser and type the following URL for Instant Messenger:
http://hostname/im

For example, http://wireless.map.beta.com/im.

To load the Instant Messaging resources, click Start and log in as kathywith the password demo.
Click any subsequent approval buttons to start the Instant Messaging client.
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Once Kathy's client has been started, click the Start button again and log in as user duncanwith
the password demo.
Do not start Instant Messenger for Tina yet.

In Duncan's main Instant Messaging window, click the Add Contacts icon (represented by a
person's head).

Type the first name of the contact you want to add (Robert) in the name field then click Find
Contact.
Robert's name appears in the Contacts to Add text area.

Type another name, say Kathy, and click Find Contact to add this name to the Contacts to Add
area.

Click OK to add these contacts to Duncan's buddy list.
Several approval dialog boxes appear.

Tip – One of the features of Sun Java System Instant Messaging is Contact List Authorization. In
this way, no one can see a given user's presence without the user's authorization. By default,
contact list authorization is turned on, but users can turn it off to give others the ability to view
their presence without authorization.

Accept all contact list authorization requests.

Repeat steps 5 through 9 to create contact lists for Robert and Kathy.
If Gaim does not display the current status of online buddies or shows a "Not Authorized" icon,
you might need to restart Gaim for presence status updates to occur.

Log off Duncan only from Instant Messaging.
Keep Robert and Kathy logged in.

Make sure that some users are logged into Instant Messaging.
Begin exploring Sun Java Communications Suite, as explained in Chapter 3.
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Communications Suite Walkthrough

This chapter provides a tutorial-type walk through of the key features of the Sun Java
Communications Suite. You experience working with the messaging, calendaring, and address
book components of the Communications Express UI, as well as use Connector for Microsoft
Outlook and Instant Messaging.

This chapter contains the following topics:

■ “Communications Suite Overview” on page 29
■ “The Communications Express Demo” on page 30
■ “The Messaging Demo” on page 32
■ “The Calendar Demo” on page 35
■ “The Address Book Demo” on page 42
■ “The Connector for Microsoft Outlook Demo” on page 45
■ “The Instant Messaging Demo” on page 47

Communications Suite Overview
Now that you have created a few user accounts and have added data to these accounts, you can
see the possibilities offered by Sun Java Communications Suite. The main accounts are duncan,
kathy, robert, and tina. For most of the evaluation, you are logged in as duncan. Single sign-on
and the access layer responsible for role and policy-based access control, which is evident in the
Instant Messaging exercises, is provided by Sun Java System Access Manager.

▼ Launch Communications Express
Start a web browser.
For this demo, use Internet Explorer.
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Type the URL of Communications Express in your browser.
http://hostname/uwc

For example, http://wireless.map.beta.com/uwc.

When the login screen appears, log in as duncanwith password demo.
The Communications Express UI appears in the browser window.

Continue with the Communications Express demo.

The Communications Express Demo
This section describes how to use the Communications Express UI to compose mail, create
calendar events, and use the address book.

▼ To Forward a Message and Schedule a Meeting
The following scenario highlights the integration between mail, calendar, and address book:
Duncan, upon starting Communications Express, views his inbox and sees an urgent email with
a document that he must review. He forwards this message to his team for review and suggests a
follow-up calendar appointment to discuss the document.

Ensure that you are logged in as user duncan as explained in “Launch Communications
Express” on page 29.

Click the email message with the subject URGENT: Please Review.
This urgent message must be forwarded to Duncan's team for review.

Click the Forward button.
The New Message window appears. Integration with Address Book is provided in the New
Message window.

Click the To icon (represented by a rolodex) to view Duncan's personal address book and select
recipients.
The Add From Address Book window appears. Duncan can search members of his Personal
Address Book or the Corporate Directory. This demo uses the Personal Address Book.

Select the To check box for Tina and Kathy to forward to them the mail Duncan received. Then
click Add Recipients.
The names of Tina and Kathy are filled in the To line in the New Message window.
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Compose a message and select the priority as Urgent from the Priority drop-down menu.

Also click the Spell Check link at the top of the window to perform an automatic spell check.

Compose the message in plain text or rich text.

Click Send when you are done composing Duncan's message.

To schedule a follow-up meeting with Duncan's team, click the Calendar tab in Communications
Express.

The Calendar view appears.

In general, you see the day view. If any group scheduling events exist for the day, a color code is
assigned to the appointment indicating how many invitees have accepted or declined the
invitation.

Click the Week view to see appointments for the week.

Click any of the + icons for the following work day to schedule an appointment.

A New Event window appears.

In the Invitee field, click Add from Address Book to add Tina, Kathy, and Duncan.

Select the check box next to their names and click Add Invitees. You can also type RoomA in the
Invitee field because Calendar Server can be used to schedule resources as well. Be sure to click
Add to add the RoomA resource.

Click Check Availability.

A Check Availability window appears showing the entire free busy for the group.

Select a free time by clicking the + icon above the time that is free.

Click Close to close the Check Availability window.

Continue filling in the New Event template.

You can modify the event type or category, the location, the frequency, or other attributes. Be
sure to include the Title, in this case, Emergency Meeting.

Click Save to schedule the event in the calendar.

The New Event window closes, and the event appears on the calendar.

You have used the Communications Express interface to use the address book, send mail, and
schedule a calendar resource.

Continue with the next demo.
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The Messaging Demo
In this section, you explore more advanced features such as message searching, sharing and
subscribing to folders, and message filtering. In the mail UI, there is a Quick Search that enables
you to search for a mail by subject and a more advanced Search that enables you to search by
several criteria.

▼ To Search Messages
While still logged in as user Duncan, click the Mail tab in the Communications Express UI.
A list of Duncan's messages appears.

Click the Search icon.
A Search pop-up appears. Search Duncan's Inbox for any email that has the word herbal in its
body. You can search on subject, sender, body, to, or cc.

Select Body from the first drop-down menu and make sure that the next drop-down menu
shows contains.

Type herbal in the blank field and click Search.
The focus changes to the Communications Express UI where the results of the search are
displayed.

Click one of the returned search messages and read it.

Note – You can search any of your folders, not just your inbox. You can also specify up to three
search criteria.

Return to the Search pop-up and click Close.

Continue with the next task.

▼ To Share Folders
While still logged in as user Duncan, click the Manage Folders icon.
The Folders view appears.

Click the New icon to create a new folder.
A dialog box appears, prompting for a folder name.
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Type the name of the new folder Presos, and click OK.
The new folder appears in the Folders list.

To share this folder, select the radio button beside the new folder.

In the Folder Actions drop-down menu, select Share Folder.
The Share Folder window appears.

From the Permissions drop-down menu, choose Read and Write to give all users read and write
permission.

Note – You can give a folder read-only permission, or read, write, and manage permission. Also,
you can share your folder with specific individuals by typing their user ID in the permissions
list.

Click OK to share the folder.
The Share Folder window closes, and the Preso folder in the Folders list now has a check mark
indicating that it is shared.

Start a separate web browser and type the URL of Communications Express.
http://hostname.map.beta.com/uwc

For example, http://wireless.map.beta.com/uwc.

The browser should be completely separate. For example, if you used Internet Explorer to
perform the previous steps, launch Firefox or Mozilla. You can also launch a browser from a
separate client system.

Log in as user robert and a password of demo.

Follow steps 1 through 7 to create a folder called Test Messages.

Click Log Out to log off Robert from Communications Express.

Continue with the next task.

▼ To Subscribe to a Shared Folder
In Duncan's Communications Express session, click the Subscribe icon at the top of the Folders
window.
A Subscribe to Shared Folders window appears.
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In the Select from Folders drop-down menu, choose All Shared Folders and click Go.
A list of shared folders appears.

Select the check box next to the Test Messages folder and click Subscribe.
You have just subscribed to the Test Messages folder and can now read mail in the folder or
move mail into the folder, provided that you have the proper permissions.

Continue with the next task.

▼ To Use Mail Options and Filters
In the Communications Express UI, click the Options tab to access the Mail Filters category.
Mail options are selected by default. You use the links to specify the category of Mail options
that you can modify. In addition to Mail Filters, you can also specify Settings, Layout, Vacation
Message and more.

To add a mail filter, click Mail Filters.
The Options-Mail Filters UI is displayed.

To define a mail filter, click New.

Type Spamfree as the filter name.

Select the Match All of the Following Conditions radio button.

Select Subject from the left-most drop-down menu and contains from the middle drop-down
menu.

In the text entry box, type free.

Click Add to add a new condition.

Select Sender from the left-most drop-down menu and does not contain from the middle
drop-down menu.

In the text entry box, type beta.com.

Select the Move Message to the Folder check box and select Trash from the drop-down menu.

Click Save to save the filter.
Now any messages that contain the word free that are not from your domain are automatically
discarded.
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Continue with the next section.

The Calendar Demo
In this section, you see the benefits of a flexible calendaring system by creating new calendars,
subscribing to calendars, grouping calendars, viewing calendars, and searching for calendars.
You also use Communications Express to create tasks. Finally, you export and import a
calendar, and you personalize your calendar by modifying calendar options.

▼ To View Calendars: User Interface
While still logged in as Duncan, in the Communications Express UI, click the Calendar tab.
When you first select the Calendar tab, your default calendar is displayed in the default view.
You can later select a calendar from the Current Calendar drop-down list to view and create
events and tasks. The Current Calendar drop-down list may include personal calendars,
subscribed calendars, calendar groups, and temporary virtual calendars. For the selected
calendar, you can see events and tasks in traditional or object oriented views that include the
Day View, Week View, Month View, Year view, Tasks View, Events View, and Invitations
View.

In the Day View, the main calendar view displays a color-coded appointment for group events.
The green box indicates the number of invitees who have confirmed the appointment, the
yellow box indicates the number who have tentatively accepted, and the red box indicates the
number who have declined the invitation. The grey box indicates the number who have not yet
responded to the invitation.

At the bottom of the Calendar tab, Duncan's calendar is:
http://wireless.map.beta.com:80/uwc/?calid=duncan@map.beta.com. Every calendar has
its own unique URL that you can send to other users. If you give users permission to view your
calendar, they can view it by using this URL.

Above this URL is the quick-event feature that enables you to create an event with a minimal set
of attributes such as event title, date, and time. This feature is ideal for creating non-recurring
events with no attendees.

Click the Week view, located as a sub-tab of the Calendar tab.
Examine the events in the calendar for the week.

To view other calendars, select a calendar from the Current Calendar drop-down menu.
Since you haven't yet subscribed to or created additional calendars, you do not see many
calendars in this list. However, after you subscribe to or create new calendars, you are able to
select and view them.
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You can view the calendars of other individuals provided that you have their permission. For
example, if you had previously subscribed to Kathy's or Robert's calendar, select
kathy@map.beta.com or robert@map.beta.com to view their calendars.

Continue with the next task.

▼ To Create and Subscribe to Calendars
Creating and subscribing to calendars is similar to mail folder operations. In this task, you
create a publicly viewable calendar called Demos and a private calendar called Family.

Select Manage Calendars from the Current Calendar drop-down menu.
The Manage Calendars view appears.

Click the New Calendar button to create a new calendar.
The New Calendar window appears.

Type the calendar information.

a. Type a Calendar Name with no embedded spaces (for example, Demos).

b. Type a Display Name, which can include spaces (for example, Demos Calendar).

Select the Anyone Can Read My Calendar check box so that this calendar is viewable by
everyone.
You might need to scroll the window to see this option.

You can also share this calendar with specific users by typing their user ID and selecting the
individual permissions check boxes.

Specify a delegated owner for this calendar by typing kathy in the Owner Name text entry area
and click Add.
You can also specify a time zone for this calendar or use the default time zone.

Click Save to create the calendar.

Click New Calendar to create another calendar.
The New Calendar window appears.

Type the calendar information.

a. Type a Calendar Name with no embedded spaces, for example, Family.
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b. Type a Display Name, which can include spaces, for example, Family Calendar.

Click Save to create the calendar.
This calendar is not publicly readable because read permission is disabled by default.

Click Subscribe to subscribe to an existing calendar.
The Subscribe to Calendar window appears.

Type tina in the Search field and click Search.
Search results are returned to the window.

Select the check box next to the calendar you want to subscribe to and click Subscribe to
Calendar(s).
The new calendar is displayed in the Manage Calendars view.

Continue with the next task.

▼ To Create Calendar Groups
Calendar groups are composite calendars formed by individual calendars superimposed upon
each other to create a single virtual calendar.

While logged in as Duncan, click New Calendar Group.

Type the Group Name MyCals.

Select duncan@map.beta.com and duncan@map.beta.com:Family from the Quick Add Personal
or Subscribed Calendar drop-down menu to create a calendar group composed of these two
calendars.

Click Save.

Click the New Calendar Group button again to create a group composed of personal and
subscribed calendars.

Type the Group Name AllCals.

Select duncan@map.beta.com, duncan@map.beta.com:Family, and tina@map.beta.com from
the Quick Add Personal or Subscribed Calendar drop-down menu to create a calendar group
composed of these calendars.

Click Save.
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Choose Duncan's Family calendar (duncan@map.beta.com:Family) from the Current Calendar
drop-down menu.

Click Week to see the Week view.

Select MyCals from the Current Calendar drop-down menu to show a composite of personal and
family calendars.
Communications Express enables you to layer your calendars on top of each other to present a
single virtual calendar.

Select AllCals from the Current Calendar drop-down menu to show all calendars that you have
subscribed to layered on top of your own calendars.
Click Month to see all events for the month.

Select duncan@map.beta.com (Duncan Hoff) from the Current Calendar drop-down menu to
return to duncan's calendar.

Continue with the next task.

▼ To Use Other Calendar Views
Click the Events link to get an Events view.

Select Events for Week from the Show drop-down menu and click Go
You can list the events by day, week, month, and by type. You can also filter these events. For
example, you might only want to show Accepted events or Declined events.

Click the Invitations link to get an Invitations view.

Select Invitations for Month from the Show drop-down menu and click Go.
You can accept a meeting from Kathy, Tina, or Robert directly from this view.

Click the Events link.

Continue with the next task.

▼ To Search Calendars
Type Emergency in the Search for Events field and click Search.
All events with the keyword Emergency appear.
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You can also search for Calendars in addition to events within calendars.

Click the Search for Calendar icon at the top of the Calendar UI.

The Search for Calendar window appears.

Type Family in the Search for Calendar text entry box and click Search.

All calendars with the word Family are displayed.

Click the Cancel button in the Search for Calendar window to dismiss the window.

Continue with the next task.

▼ To Create New Calendar Tasks
A task is a single item that you need to do. Tasks are similar to events and are created in almost
the same way. The difference between tasks and events is that tasks appear in a tasks bar to the
left of the calendar and events appear within the Calendar itself. Tasks also have a completion
status whereas events do not. If team members collaborate with one another, the task feature
lets members notify one another of a task's status or when a task is completed. In this demo, you
create a public task that others can view when they subscribe to your calendar.

Click the Week view tab.

Click the New Task icon.

The New Task window appears.

Fill in the task template.

a. Type Progress Report in the Title field.

b. Verify that the Start Date and Due Date are today's date.

c. Set the Due Time for 5:00 PM or some other time in the future.

d. Select 25% from the Status drop-down menu.

e. Select Public Task from the Privacy drop-down menu.

f. Type a Location.

g. Type Use the Progress Report format in the Notes field.
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h. Scroll down to the Attachments area of the New Task window and click Add Attachment to
add an attachment to this task.

The Attach File window appears.

i. Click Browse to search for an appropriate attachment to add to this task.

Imagine that this is a file containing the "Progress Report format." A series of windows
appears eanbling you to select the file. After selecting the file, click Add to add the
attachment. Then click Attach to attach the file to the task.

Click the Save button.

The newly created task appears in the task bar to the left of the Calendar. If you click this task,
you are able to retrieve the attachment. Calendar Server provides attachment support for both
events and tasks.

Continue with the next task.

▼ To Import and Export Calendars
Occasionally, you export a calendar to a file to import into another calendar. For example, you
have subscribed to a read-only calendar but you want your own copy that you can modify. Or,
you want to share a calendar with others who do not have access to your calendar server. You
might also want to export your calendar to make a backup copy.

Sun Java System Calendar Server supports the iCalendar standard calendar schema definition
(RFC 2445), and consequently can import and export calendar data in this format. Calendar
Server can also import and export calendar data in an XML format.

In this demo, will export your default calendar to a file and then import that file into an empty
calendar.

Click the Import/Export icon.

The Import and Export Calendar window appears. You will first perform a calendar export.

In the Calendars to Export drop-down menu, select duncan@map.beta.com (Duncan Hoff).

This is Duncan's default calendar.

In the File Format drop-down menu, select iCal.

An XML format is also available. You can also export calendar data with attachments.

Select All for the Date Range.
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Click Export to export the calendar data.

You see one or more dialog boxes requiring you to verify that you want to save a file.
Additionally, you are prompted for a location to save the file. Note the location where the
export.ics file is saved.

Approve all dialog windows to save the calendar file and dismiss any pop-up windows that
remain after the file has been saved.

The Import and Export Calendar window should stay visible. Do not dismiss this window
because you use it to import the recently saved file.

In the Import to Calendar drop-down menu, select the recently created empty calendar called
Demos.

If you do not have an empty calendar, create one. See “To Create and Subscribe to Calendars”
on page 36.

Click Browse to select the recently exported file that is inserted into the Import from File field.

When you click Browse, a window appears prompting you to select the file that you exported
earlier. By default, the file name is export. When you have located and selected the file, click
Open to insert the file name into the Import from File field.

In the File Format menu, select iCal.

An XML format is also available.

Select All for the Date Range.

Click Import to import the calendar data into the Demos Calendar.

The following message appears at the top of the Import and Export Calendar window:
Successfully Imported the data to the selected calendar

Click Close to close the Import and Export Calendar window.

From the Current Calendar menu, select the duncan@map.beta.com:Demos calendar to view
the results.

Notice that this calendar has the same events that are in Duncan's default calendar. Also notice
that it is not possible to modify these events because the calendar id (calid) of the Organizer
does not match the calid of the Demos calendar. To modify events, edit the export.ics file and
change the value of the ORGANIZER's calid from duncan@map.beta.com to
duncan@map.beta.com:Demos.

Continue with the next task.
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▼ To Set Calendar Personalization Options
In this demo, you familiarize yourself with some of the calendar personalization options.

In the Communications Express UI, click the Options tab.
The Calendar Options user interface appears. The option interface allows you to personalize the
appearance of the calendar user interface. You can change the default calendar view, the daily
time scale, how you want the work week to appear, and more. The default calendar time zone is
a global property that other applications can use.

Click the Global tab just beneath the Mail tab to access the global time zone property.
You see the default time zone for this calendar. Change the time zone by selecting it from the list
that appears.

Select your appropriate time zone then click the Save button.

Continue with the next demo.

The Address Book Demo
The Address Book is the core component of Communications Express that ties together mail
and calendar functionality. Not only can the Address Book be used to create a rich amount of
information for each contact, but it can also be used to launch a variety of actions for each
contact.

▼ To Experience Address Book
In this exercise, you create a contact, and you perform an action using that contact. You also
familiarize yourself with the methods to create contacts.

Click the Address Book tab at the top of the Communications Express UI.

Select the check box next to Kathy's name and select View Calendar from the Select action
drop-down menu.
Kathy's calendar is displayed.

Tip – You can also send email by selecting Send Email.

Click the Address Book tab and click the double checked box above all the check boxes.
All check boxes are selected.
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Select View Calendar again.

All selected calendars can be viewed at the same time.

(Optional) Create new contacts.

Click the New Contact icon, or use the quick add feature, to add a contact. You can also use the
Address Book user interface to search, group, import, export, and print.

Continue with the next task.

▼ To Create, Share, and Subscribe to Address Book
Communications Suite supports the creation and management of multiple address books in
addition to your default Personal Address Book. In this exercise, you create a new address book
and share it so that others can view its contents.

Click the Address Book tab at the top of the Communications Express UI.

Select Manage Addressbooks from the Current Address Book drop-down menu.

The Manage Addressbooks view appears.

Click the New button to create a new address book.

The Create Addressbook window appears.

Type the address book information.

a. Type an Address Book Name (for example, Friends and Family).

b. Type a Description (for example, Address Book of friends and family members) .

Select the Anyone can read my Addressbook checkbox so that this address book is viewable by
everyone.

You can also share this address book with specific users by typing their user ID and selecting the
individual permissions check boxes.

Click Save to create the address book.

You have now created a new address book that can be viewed by others.

Select the new address book that you created from the Current Address Book drop-down menu.

The new address book view appears. For instance, if your address book was called Friends and
Family, the Friends and Family address book view appears.
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Click the New Contact icon to add a contact to this address book.
The New Contact window appears.

Type a First Name, a Last Name, and a Primary Phone number in the appropriate entry boxes.
Then click Save.

Log out as user Duncan.

You are now logged out of the current session. You will log in as a different user and will
subscribe to the newly created address book.

Continue with the next demo.

▼ To Subscribe to Address Book
In this exercise, you subscribe to an existing address book that someone else has created and
shared.

At the Sun Java Communications Express login screen, log in as user tina. The password is demo.

Click the Address Book tab.

Select Manage Addressbooks from the Current Address Book drop-down menu.
The Manage Addressbooks view appears.

Click the Subscribe Addressbooks button to subscribe to a shared address book.
The Search Address Book window appears.

Type duncan in the Search field and click Search.
Search results are returned to the window.

Select the check box next to the address book you want to subscribe to and click Subscribe.
You can refresh the view to note that the new address book has been added.

Select the newly subscribed address book from the Current Address Book drop-down menu.
You are now able to view the contents of the address book. Note that the icons for creating new
contacts or for performing other modifications have been greyed out. You can only view this
address book.

Click Log Out to log out of the current session.
You have new finished the Communications Express evaluation.
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Continue with the next demo.

The Connector for Microsoft Outlook Demo
Clients are generally classified as either thick clients (also known as a fat client or rich client) or
thin clients (also known as web clients). A thick client performs the bulk of any data processing
operations itself and relies on the server it is associated with primarily for data storage. A thin
client relies on a web server for data processing operations. So far, you have seen how to use the
Communications Express thin client for evaluating Sun Java Communications Suite. Now you
will learn how to use a thick client such as Evolution or Microsoft Outlook. Thick clients
provide certain features that the Communications Express web client does not, such as drag and
drop capability and disconnected support. The Sun Java Communications Suite supports the
use of Microsoft Outlook on the front end for email, calendar, and address book.

▼ To Experience Connector for Outlook
Install and configure Sun Java System Connector for Microsoft Outlook on your desktop system.
For this demo, use the ports and organization DN specified in “Using the Single Host
Deployment Example” on page 17. You then create a profile for Duncan Hoff.

See the Connector for Outlook documentation for instructions on how to install and configure
Connector for Outlook: http://docs.sun.com/app/docs/coll/1630.1

Execute Duncan's profile then start Microsoft Outlook.
You do this only one time. Upon starting Microsoft Outlook, you see the Outlook Today view,
which provides a summary of your appointments, tasks, and messages.

Click the Calendar icon in the Outlook Shortcuts pane.
Your daily or weekly schedule is displayed.

Drag and drop one of the meetings to a new time, for example, drag the Emergency Meeting
you created earlier.
You might have to advance to the following day to see this meeting. If this event has invitees,
approve attendees being notified of the event change.

Maximize the Communications Express window and refresh the Calendar view.
The event time has changed for the event you dragged.

Click the Inbox in the Outlook Shortcuts pane.
You should see your Inbox.
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Click on a message in your Inbox to view it.
For example, click the Urgent message from Robert Smith.

The mail displays.

In Microsoft Outlook, click the New icon to compose a new message.
A new window allows you to compose a message.

Click the To: or CC: buttons to address your email.
You can show names from your Contacts, but you can also select the Global Address List.

Select Global Address List from the menu.
Connector for Microsoft Outlook requires access control changes to the directory server to
support the Global Address List. See Tuning LDAP to Improve Searches in Communications
Services Clients for more information. If the directory server has been configured to support the
Global Address List, you are able to view all the users in the Directory. You do not actually send
email to anyone is this list.

Click Cancel to close the Select Names window.

Close the Compose window and reject any requests to save changes.

Click Contacts in the Outlook Shortcuts pane.
You should see your address book contacts.

In Microsoft Outlook, create a new contact.

a. Type a full name and an email address.

b. Save the contact.

Click the Address Book tab in Communications Express to see the new contact.

Experiment with other Connector for Outlook features.

Continue with the next demo.
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The Instant Messaging Demo
In this section, you start the Sun Java System Instant Messaging client, Instant Messenger, and
use it on its own. Like Sun Java System Messaging Server and Sun Java System Calendar Server,
Sun Java System Instant Messaging is also standards based. Java System Instant Messaging uses
the XMPP protocol, which is an IETF standard also referred to as the Jabber standards. Because
the Instant Messaging server and client communicate using XMPP, they can interoperate with
any other XMPP-compliant server or client.

▼ To Chat
Robert is already logged in as a Gaim user and Kathy is logged in as a Sun Java System Instant
Messaging user. For more information about Gaim, see “To Create Sample Instant Messaging
Data” on page 27. You launch Instant Messenger as Duncan. If Gaim does not show Kathy's
status as online, restart the Gaim client in order for presence status updates to begin. If presence
updates still do not occur, there might be an issue with presence authorization. To fix this,
remove the buddies from Gaim and Sun IM, adding them again, and approving all contact list
authorization requests. Then restart Gaim to initiate presence updates.

Type the URL of the Instant Messenger Resources in your browser.
http://hostname/im

For example, http://wireless.map.beta.com/im.

To load the Instant Messenger Resources, click Start and log in as duncan with the password
demo. Click any subsequent approval buttons to start the Instant Messaging client.

The Instant Messaging window appears with a list of Duncan's contacts and contact groups. If
there are no contact groups, you can create one later.

Start chatting with Robert by double-clicking on Robert's presence icon.

Robert's name appears in a tab in the chat window. You can change the text font, size, color and
more while chatting. Instant Messaging also supports emoticons and file attachments.

From Duncan's buddy list, start a chat with Kathy by double-clicking on Kathy's presence icon.

Duncan's chat window now shows two tabs: one for Robert and one for Kathy. You can have
multiple simultaneous chat sessions from the same chat window through this tabbed interface.

Continue with the next task.

Before You Begin
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▼ To Manage Individual and Multiple Buddy Chat
Sessions
Use this procedure to end one chat session while keeping other chat sessions active.

In Duncan's chat window, click the tab for Robert.

Click the File link and select Leave.

Approve any verifications.

This does not affect your chat session with Kathy.

Chat more with Kathy.

Continue with the next task.

▼ To Invite Others to Chat
You can invite others to join your current chat window.

In Duncan's chat window, click Invite Users to Chat (icon of a person's head).

Invite Robert to rejoin the chat then click OK.

To invite Robert, you can either select his name from the Contacts List and click the Add
button; or, you can enter his name or User ID in the appropriate field.

Type an invitation such as Welcome and click OK.

As Robert, click Accept to accept the chat invitation.

Robert is now part of the chat room. This is a dynamic conference room which is different from
the persistent conference rooms you will explore later.

Close Robert's chat window and quit Gaim.

Close all other chat windows from Duncan and Kathy.

Do not quit the Instant Messaging applications for Duncan and Kathy.

Continue with the next task.
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▼ To Create Alerts and Polls
Alerts are pop-up notifications that can be sent to others. Polls are instant surveys that can be
sent to others.

From Duncan's main Instant Messaging window, select Kathy and choose Alert from the Tools
drop-down menu.
The Send Alert window appears.

Type a subject and compose your alert message.
You can vary the text font, color, place an image, and more.

Select the Show Delivery Status check box and click Send.
The alert appears.

Close all alert windows.

From Duncan's main Instant Messenger window, select Kathy again.

Choose Poll from the Tools drop-down menu.
The Poll Users window appears.

Type a poll question.
To change the available answers, highlight the existing answers and remove them. Click Add
Answer to add your own answers.

When your poll question is complete, click Send.
The poll question is sent. As the poll sender, Instant Messaging informs you of the recipients'
answers to the poll.

Continue with the next task.

▼ To Create Conference Rooms
No conference rooms exist for you to subscribe to. However, at the beginning of this evaluation,
you used Access Manager to grant Duncan permission to create conference rooms, so you now
exercise this functionality to create a few conference rooms.

Note – Users Tina and Kathy do not have permission to create conference rooms. You can
modify their permissions by using Access Manager.
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In Duncan's main Instant Messenger window, click the Conferences tab. In Kathy's main Instant
Messenger window, click the Conferences tab.

In Duncan's Instant Messenger client, choose Manage Conferences from the Tools drop-down
menu.

The Manage Conferences pop-up window appears.

Click New Conference to create a conference room.

You are asked for a conference room ID and name. For simplicity, choose the same name for
both the ID and the name, for example, ID: Stocks, name: Stocks).

Change the Default Access to WRITE then click OK.

The Manage Conferences pop-up displays the new conference room. If the new conference
room does not appear, you might need to restart the Instant Messaging server and Web Server
to enable the policy controls established in a prior section. If this is the case, quit both Instant
Messaging sessions for kathy and duncan before refreshing the Instant Messaging server.

Click the New Conference button a second time to create a moderated conference room.

When prompted for ID and name, type moderated, leave the Default Access at READ and click
OK.
The Manage Conferences pop-up window displays the new conference room.

Click OK in the Manage Conferences pop-up window to dismiss this window.

As Kathy, choose Add Conferences from the File drop-down menu to add a conference room to
the list of subscribed rooms.
The Add Conferences pop-up window appears.

Click Browse Conferences to get a list of all available conference rooms.

Select the moderated room and click OK, then click the Browse Conferences button again and
select any conference room other than the moderated room. For example, select Stocks and
click OK.
The selected room appears in the Add Conferences window.

a. Click OK to add the conferences in the Conferences tab.

b. Make sure that both Duncan and Kathy have at least one identical conference (other than
the moderated conference) in their main Instant Messenger window.

As Duncan, double-click the name of the conference (other than the moderated room) to join it.
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As Kathy, double-click the name of the same conference.
Now both members can chat in this conference room.

Continue with the next task.

▼ To Moderate Conference Rooms
Because Duncan created the moderated room, he is the moderator by default. He can add
additional moderators by giving them Manage access.

Close all chat windows for both Duncan and Kathy.

As Duncan, double-click the moderated conference room.

In Kathy's Instant Messenger window, double-click the moderated conference room.
Notice that Kathy's chat window behaves differently than Duncan's window. Kathy has only
read permission, but Duncan has read, write, and moderate permission.

In Duncan's chat window, choose Moderate from the File menu.
Both Kathy's and Duncan's windows change. Resize the corner to change the vertical size of
Duncan's window to see all of the options.

As user Kathy, type in a chat message and send it.

As user Duncan (the moderator), accept the message.
To accept the message, highlight it and click Accept. If Kathy's message does not appear in the
moderate pane for Duncan to accept, quit the chat windows for both users and double-click the
moderated conference room again for both users. Then resume from step 4.

Upon accepting it, the message appears in the main chat portion of the window for all
participants to see.

Close all chat windows for both Duncan and Kathy.

Continue with the next task.

▼ To Define Access and Privacy Filters
Users can define their own privacy filters that can be used to block Instant Messaging from
certain individuals or prevent users from seeing another user's presence status.

As Duncan, choose Settings from the Tools menu.
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Select the Privacy tab.
A short list of Privacy Profiles have already been defined.

Click New Profile to add a new privacy profile.
The New Profile pop-up window appears.

a. In the Name field, type PriorityIM and check the Only Users in My Contacts radio button.
Checking the radio button limits the presence updates to only those users in Duncan's
contact list.

b. Under Block Instant Messages From, check the Only These Users radio button and click Add
to define a list of users whose instant messaging traffic you want to block.
The Block Users pop-up window appears.

c. In the Name field, type Test and click Find Recipient.

d. Select the Test user and click OK to add this user to the blocked list.
The Test user appears in the Only These Users list in the New Profile window.

Click OK to create the PriorityIM privacy profile.
This new profile appears in the list of available privacy profiles. You can select any profile to
activate it.

Click Close to close the Settings window.
You have now completed the basic evaluation demos. You can continue with a look at more
advanced Communications Suite features described in Chapter 4.
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Communications Suite Advanced Features

This chapter describes some of the advanced features of Communications Suite.

This chapter contains the following sections:

■ “Using Advanced Instant Messaging Features” on page 53
■ “Using the HTTP Proxy Gateway” on page 58
■ “Delegated Administration Demo” on page 59
■ “Starting and Stopping Services” on page 62

Using Advanced Instant Messaging Features
This section describes how to use Access Manager to provision users and how to configure
archiving for Instant Messaging. Access Manager enables you to create roles and policies and
apply those to users to define their access rights. Previously, this guide described how easy it is
to assign a user to a given role. This section enables you to examine policy and role creation to
define a new Instant Messaging policy.

API Level Filtering
In “The Instant Messaging Demo” on page 47, you learned that access and privacy filters can be
used by end users to block Instant Messaging traffic or presence updates from certain
individuals. Additional flexibility can be obtained by deploying filters that perform text
conversion or block certain payloads that contain viruses. For example, an administrator can
create a filter that blocks or converts obscene words in an instant messaging conversation.
Other uses include text translation, rich text to plain text conversion, or domain level blocking.
Sun Java System Instant Messaging provides a Message Conversion API that developers can use
to create more complex filters that can be applied to the Instant Messaging Server. Learn more
about API level filtering from the Instant Messaging product documentation
(http://docs.sun.com/app/docs/coll/1309.3).
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▼ To Provision Users with Access Manager
In this task, you perform feature-level access control, a powerful tool that enables or disables
client functionality. You create a new instant messaging role and corresponding policy that
limits the instant messaging functionality to the basic features. Users assigned to this new role
are not able to join conference rooms, send polls, or perform any of the other advanced instant
messaging tasks.

Access Manager uses the Instant Messaging Service and the Presence Service to manage the
Instant Messaging policy. The Instant Messaging Service contains the policy rules for
communicating with others, as well as the ability to chat, exchange files, join conferences, send
alerts, and more. The Presence Service contains the policy rules for determining the ability of
users to share their presence with others, as well as to access, manage, or publish one's presence.

Use a completely new web browser to start Access Manager.
For example, http://wireless.map.beta.com/amconsole.

If you are using Internet Explorer for the Portal Server desktop and Communications Express,
start Mozilla or Firefox.

Log in as user amadminwith the password adminpass.

In the top level organization (o=isp), choose Roles from the View drop-down menu in the left
pane of the Access Manager console.

Click New to create a new role.

a. Select Static Role, type IM Limited User in the Name field, and click Next.

b. Define the following:

■ Description: Limited access role

■ Type of Role: Service
■ Access Permissions: Organization Administrator

c. Click Finish to create the role.
Now that you have created this new role, create policies that apply to this role.

Click the Service Configuration tab to add the appropriate Subject Type.
You will use the Subject Type to define a subject for the new policy you will create later.

a. In the left pane, click the property arrow beside Policy Configuration.

b. In the right pane, scroll down until you see a list of Selected Policy Subjects. In Selected
Policy Subjects, choose all the available subjects, then click Save.
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c. Click the Identity Management tab.

d. Choose Services from the View drop-down menu in the left pane.

e. Click the property arrow beside Policy Configuration.

f. Verify that all Selected Policy Subjects are selected.

In the top level organization (o=isp), choose Policies from the View drop-down menu in the left
pane of the Access Manager console.

Click New to create a new policy.

a. Select Normal, and type Limited access instant messaging in the Name field.

b. Click OK.

c. In the Description field, type Policy for Limited access instant messaging users and
click Save.

Choose Rules from the View drop-down menu in the right pane of the Access Manager Console.

Click the New button to define rules for this policy.

a. Select Instant Messaging Service for the Rule Type and click Next.

b. Type IMLimitedRule for the Rule Name.

c. Type IMResource for the Resource Name.

d. Select all Action check boxes.

e. Click the Deny radio button for the following Actions:

■ Ability to Exchange Files
■ Ability to Join Conference Rooms
■ Ability to Manage Conference Rooms
■ Ability to Manage News Channels
■ Ability to Moderate Conference Rooms
■ Ability to Read News
■ Ability to Send Alerts
■ Ability to Send Polls

f. Click Finish.
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g. Click Save.

You have successfully created an Instant Messaging Service rule for this policy.

Click New to define another rule for this policy.

a. Select Presence Service for the Rule Type and click Next.

b. Type PresenceLimitedRule for the Rule Name.

c. Type PresenceResource for the Resource Name.

d. Select all Action check boxes, but do not click any Deny radio buttons.

All Actions are allowed.

e. Click Finish.

f. Click Save.

You have successfully created a Presence Service rule for this policy.

Choose Subjects from the View drop-down menu in the right pane of the Access Manager
console.

Click New to define the mapping between policies and roles.

a. Ensure that the Subject Type is Access Manager Roles and click Next.

If "Access Manager Roles" is not an available Subject Type, restart Web Server and retry this
step.

b. Type IM Limited User in the Name field then click Search to search through the list of
available Access Manager Roles.

c. Find the role isp > IM Limited User, highlight this role, and click Add.

d. Click Finish.

e. Click the IM Limited User checkbox, then click Save.

The new roles and policies have been created. Next you assign Tina to this new Role and note
the effect on her Instant Messaging client.

Choose Roles from the View drop-down menu in the left pane of the Access Manager console.
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Click on the properties arrow to the right of the IM Limited User role.

The IM Limited User pane appears.

In the right pane, choose Users from the View drop-down menu.

a. Click Add on the right pane.

b. Type Tina in the User ID field and click Next.

c. Select the check box next to Tina's name and click the Finish button.

You have assigned Tina the Instant Messaging Limited User Role, so she has limited access to
Instant Messaging.

Choose Organizations from the View drop-down menu in the left pane of the Access Manager
console.

Click the link of the organization where user tina exists, for example map.beta.com

Choose Services from the View drop-down menu in the left pane of the Access Manager console.

Click on the properties arrow to the right of the Policy Configuration service.

The Policy Configuration pane appears.

In the right pane, type the LDAP Bind Password in the appropriate text entry boxes. (For
example, type adminpass.) Then click Save.

Launch the Instant Messenger client then log in as tina.

Duncan initially has kathy and robert in his Instant Messaging buddy list. The user tina has
not yet been added. You can click the Start button from the same Instant Messenger window
you used to start kathy. If you start Tina's Instant Messenger, notice that her window has very
limited Instant Messaging functionality. This type of provisioning is feature-level provisioning
that involves defining roles and policies for these roles. Changing the policy has the effect of
removing or adding functionality to the client itself. You can experiment changing the policy
and restarting Tina's client to observe the effect. You can also apply the appropriate role to
others and see its effect as you start Instant Messaging as those users.

▼ To Archive Chat Sessions
The Sun Java Communications Suite provides the following two ways to archive chat sessions:

■ Archive provider API. Using this API, developers can extend the archive capability.
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■ Portal Server search database or Message Store. Without changing any capabilities, you
can archive chat sessions in Portal Server's search database or in Messaging Server's Message
Store.

By default, the single host deployment example, on which this evaluation guide is based, uses
the Message Store to archive chat sessions. By viewing Duncan's inbox, you can see that he has
several messages that contain the chat conversations he had with Kathy and others.

The single host deployment example, on which this evaluation guide is based, does not include
the Portal Server as an installation component. To change the archive store from the Message
Store to the Portal Server search database requires that the Portal Server first be installed.
Installation of the Portal Server is beyond the scope of this evaluation. However, if you install
the Portal Server, you can change the archive store to the Portal Server search database to
archive chat sessions by doing the following:

Edit the /etc/opt/SUNWiim/default/config/iim.conf file and set the following parameter:
iim_server.msg_archive.provider = "com.iplanet.im.server.IMPSArchive"

Restart the Instant Messaging server.
/opt/SUNWiim/sbin/imadmin refresh

Perform a poll, or a chat, to generate some Instant Messaging data. For performing poll or chat,
see “The Instant Messaging Demo”on page 47.

Click the Search tab from within Duncan's Portal Server desktop.

In the Find field, type a key word such as pollor a word from the chat, and click Search.
The results of the search are displayed. Note that the poll results look like actual final poll
results, not extraneous data points. Also, the entire conversation is returned, not just the
sentence containing the keyword.

Using the HTTP Proxy Gateway
Sun Java System Instant Messaging has an HTTP proxy gateway to connect simple HTTP
clients to the Instant Messaging server. Uses for this include phone clients, simple web-based
clients, or other clients. You can install web-based clients such as jwchat into a web container
and use them in conjunction with your host.
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Delegated Administration Demo
In addition to command-line tools and Access Manager, Communications Suite has a graphical
user interface called Delegated Administrator, that you can use to provision users, domains,
and service packages.

This section walks you through a scenario that uses Delegated Administrator as if you were a
service provider hosting email for several small companies. As this service provider, you have
just signed an agreement with a new company. You now need to provision the new domain and
add the required mail service for that domain. As the administrator for the service provider, you
must also create a domain administrator who has access to that specific domain only.

▼ To Create a Domain
In this task, you create a new domain for hosting email and you assign different levels of service
to this domain.

Type the following URL of Delegated Administrator in your web browser.

http://hostname/da/DA/Login

For example, http://wireless.map.beta.com/da/DA/Login.

Log in as user amadminwith password adminpass.

The main Delegated Administrator view appears. You are logged in to the root organization
and the default domain appears in the organization list.

Click New Organization.

The New Organization pop-up window appears.

For the Organization name, type demoone.com, and for Domain Status, select Active and click
Next.

Skip the Contact Information screen and click Next.

The Account Information screen appears.

Type demoone.com in the Domain field. Click the Default Administrator checkbox to create the
default Organization Administrator Account. Type a Login ID and Password for this account, for
example admin_demoonewith password adminpass. Then click Next.

The Select Service Packages screen appears.
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Because you are interested in only enabling hosted mail, choose Service Packages that only
contain mail.

Several packages are available, depending on the desired mail quota. To display all the packages
in a single page, click the icon at the top of the Service Packages table that represents a mapping
from multiple pages to one page. This will enable you to show the service package data in a
single page. Select the bronze, silver, and platinum check boxes and click Next.

The Mail Service Details screen appears where you allow the administrator to define disk and
attachment quotas for the domain.

For the Preferred Mail Host, type your host name, for example, wireless.map.beta.com and
click Next.

The Quantity of Service Packages screen appears.

(Optional) If calendar service packs were chosen, establish calendar session timeouts and other
attributes through Calendar Service Details.

Calendar Server has not been configured for hosted domains, so leave all the fields blank and
click Next.

Define the number of Service Packages you would like to assign to this domain.

Because this is a small company of less than 50 people, assign 30 service packages for each type
of service.

a. Change the number from 1 to 30 for silver, platinum, and bronze service packages and click
Next.

The Summary screen appears. The Organization Administrator is automatically created and
a password is generated.

b. Note that the Organization Administrator is defined as expected.

Click Finish.

You have created your first domain.

Click the Log Out link to exit Delegated Administrator.

▼ To Create Users
You have just learned to create domains. In this demo, you will log in as the organization
administrator and create users.
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At the Delegated Administrator Login screen, log in as the domain-level administrator.

Use the ID and password from the section“To Create a Domain” on page 59, for example,
admin_demoone with password adminpass.

To Create users for this company, click the New button.

The New User pop-up window appears.

a. Type the following:

■ First Name: Larry
■ Last Name: Brown
■ Display Name: Larry Brown

b. Click Next.

c. Skip the Contact Information screen and click Next.

The Select Service Package screen appears.

d. Select one of the three packages, for example, bronze. Click Next.

e. Type the mail service details.

Instead of accepting the default Email Address, change the email address to
lbrown@demoone.com and click Next.

f. (Optional) If you chose a service pack that included calendar service when you originally
created your domain, you will see a Calendar Service Details screen.

If you left all the calendar fields blank when you created the domain, you can leave all the
fields blank in this screen also and click Next.

g. Change the Login ID from Larry_Brown to lbrown. Type the password demo and click Next.

h. Verify the User Information then click Finish to create the user.

Look in the Delegated Administrator user interface to see that the new user has been added to
the demoone.comdomain.

Click the Log Out link to exit Delegated Administrator.

Continue with the next task to verify that the user ID can log in.
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▼ To Log in as a Newly Created User
Type the following URL of Communications Express in your web browser. For example,
http://wireless.map.beta.com/uwc

For this example, the User Name is lbrown@demoone.com and the password is demo.

You are now logged into Communications Express as Larry Brown.

Send test messages to yourself or to other users, such as duncan, kathy, tina, and robert in the
map.beta.comdomain.

Starting and Stopping Services
This section describes the commands needed to start and stop all the Communications Suite
services.

▼ To Start and Stop Services
You should stop services before attempting to start them.

To stop services:
Instant Messaging /opt/SUNWiim/sbin/imadmin stop

Access Manager /etc/init.d/amserver stop

Web Server /var/opt/SUNWwbsvr7/https-wireless.map.beta.com/bin/stopserv

Calendar Server /opt/SUNWics5/cal/sbin/stop-cal

Messaging Server /opt/SUNWmsgsr/sbin/stop-msg

Administration Server /var/opt/SUNWwbsvr7/admin-server/bin/stopserv

Directory Server /opt/SUNWdsee/ds6/bin/dsadm stop

/var/opt/SUNWdsee/dsins1

To start all services:
Administration Server /var/opt/SUNWwbsvr7/admin-server/bin/startserv

Directory Server /opt/SUNWdsee/ds6/bin/dsadm start

/var/opt/SUNWdsee/dsins1

Messaging Server /opt/SUNWmsgsr/sbin/start-msg

Calendar Server /opt/SUNWics5/cal/sbin/start-cal
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Web Server /var/opt/SUNWwbsvr7/https-wireless.map.beta.com/bin/startserv

Access Manager /etc/init.d/amserver start

Instant Messaging /opt/SUNWiim/sbin/imadmin start

Starting and Stopping Services
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Getting More Information About
Communications Suite

Use the following to obtain more information about Sun Java Communications Suite, or get
assistance from the Sun Java Communications Suite staff.

For More Information
Use the following links to learn more about Sun Java Communications Suite:

■ http://www.sun.com/bigadmin/hubs/comms

■ http://www.sun.com/comms

■ http://docs.sun.com/app/docs/prod/sj.comm.suite#hic

Contacting Sun
For assistance with Sun Java Communications Suite, use the following Sun Forums:

Sun Java System Messaging Server Forum http://swforum.sun.com/

jive/forum.jspa?forumID=15

Sun Java System Calendar Server Forum http://swforum.sun.com/

jive/forum.jspa?forumID=3

Sun Java System Instant Messaging Forum http://swforum.sun.com/

jive/forum.jspa?forumID=113

5C H A P T E R 5
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